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I rxif Print

This printer supports Exif 2.2 (also called “Exif Print”).

Exif Print is a standard for enhancing the communication between digital cameras and printers. By
connecting to an Exif Print-compliant digital camera, the camera’s image data at the time of shooting is
used and optimized, yielding extremely high quality prints.

I Canadian Radio Interference Regulations

This digital apparatus does not exceed the Class B limits for radio noise emissions from a digital appa-
ratus as set out in the interference-causing equipment standard entitled “Digital Apparatus,” ICES-003
of the Industry Canada.

Cet appareil numérique respecte les limites de bruits radioélectriques applicables aux appareils
numériques de Classe B prescrites dans la norme sur le matériel brouilleur NMB-003 d'Industrie
Canada intitulée « Appareils numériques ».

I 11 tcrnational ENERGY STAR® Program

As an ENERGY STAR® Partner, Canon Inc. has determined that this product meets the ENERGY
STAR guidelines for efficiency.

The International ENERGY STAR® Office Equipment Program is a global program
/\ that promotes energy saving through the use of computer and other office equipment.
W The program backs the development and dissemination of products with functions
that effectively reduce energy consumption. It is an open system in which business
can participate voluntarily. The targeted products are office equipment such as com-
puters, monitors, printers, faxes and copiers.
Their standards and logos are uniform among participating nations.

I rovver Requirements

Never use a power supply voltage other than that supplied in the country of purchase. Using the incor-
rect voltage could cause a fire or electric shock. The correct power supply voltages and frequencies are

as follows:
Europe AC 230V£10%, 50Hz
USA/Canada  AC 120V, 60Hz
Australia AC 240V, 50Hz

Printer Model: K10210 (i9100)



Preface
Shipping Materials

Thank you for purchasing a Canon Bubble Jet Printer.
Check that all the following items are in the box. If anything is missing or is damaged, contact your Canon
Authorized Dealer or Sales Representative.

U Printer

U Setup Software & User’s Guide CD-ROM
O Quick Start Guide

O Print Head

U 6 Ink Tanks

* Cables should be purchased separately according to your computer. For details on cable type and
specifications, refer to page 3.

Introduction

This Quick Start Guide uses the following symbols to indicate important information. Always observe the
instructions indicated by these symbols.

Instructions that, if ignored, could result in death or serious personal injury caused by incorrect
operation of the equipment. These must be observed for safe operation.

Instructions that, if ignored, could result in personal injury or material damage caused by incorrect
operation of the equipment. These must be observed for safe operation.

Also read the Safety Precautions in the User’s Guide. Observe the warnings and cautions to avoid
personal injury or damage to the printer.

‘. .

Trademark Notices
+ Canon® is a registered trademark of Canon Inc.
« BI™is a trademark of Canon Inc.

+ Microsoft® and Windows® are registered trademarks of Microsoft Corporation in the U.S. and other
countries.

* Apple, Mac, Macintosh are trademarks of Apple Computer, Inc., registered in the U.S. and other
countries.

 All other trademarks and registered trademarks appearing in this Quick Start Guide are the property of
their respective owners.

Copyright ©2003 CANON INC.
All rights reserved. No part of this publication may be transmitted or copied in any form whatsoever
without the express written permission.




Setting Up

1 Preparing the Printer
1 Place the printer on a flat surface.

Remove the tape and the shipping
material from the printer as shown.

The tape position is subject to change.

Attach the paper rest to the sheet
feeder.

4 Lower and pull out the output tray as
shown.

output tray



2 Connecting the Printer to the Computer

Use a USB cable.

Recommended: Canon or other computer
manufacturer cable, up to 2 meters in length.

= Notes
« If your computer has an earth connection, make sure that this is attached.
« If you do not intend to use the printer for a long period of time, unplug the power cord from the
power outlet after turning off the printer.

Follow the steps below to install the printer driver

correctly.
1 Ensure the printer and the computer are
switched off.

2 Connect the cable.

= Note

If the Add New Hardware Wizard or Found New Hardware
Wizard screen appears when carrying out the following
operations, click Cancel and turn off the computer.

‘Welcome to the Found New
Hardware Wizard

This wizard helps you nstal software for

(), 1 your hardware came with an nstallaion €D
&2 or Hloppy disk. insert it now.




3 Installing the Print Head

 Never attempt to plug the power cord into the power outlet or unplug the power cord when your
hands are wet.

» Never damage, modify, stretch, or excessively bend or twist the power cord. Do not place heavy
objects on the power cord.

» Never use any power supply other than the standard power supply available in the country of
purchase. Using the incorrect voltage and frequency could cause a fire or electric shock.

 Always push the plug all the way into the power outlet.

M Installing the Print Head
1 Plug the printer in.

Turn on the printer. Do NOT turn on the
computer yet.

The POWER lamp flashes and the printer begins to
operate. Wait until the POWER lamp remains fully lit.

3 Open the front cover.

4 Remove the tape.

Do not touch internal parts other than the lock lever.

%\ 5 Raise the lock lever.
i




6 Remove the protective cap from the
print head.

= Notes electrical  print head

* Do not touch the print contacts  nozzles

head nozzles or
electrical contacts.

* Do not attempt to
reattach the protective
cap once it has been
removed.

7 Place the print head in the holder.

= Note
Be careful not to touch any parts inside the printer.

8 Lock the print head into place by
lowering the lever.

oy

Do not touch the lock lever once the print head has been
installed.

T =
B Installing the Ink Tanks

* For safety reasons, store ink tanks out of the reach of small children.
* Do not drop or shake ink tanks.
1 Take out the yellow ink tank.

2 Pull the orange tape in the direction of
the arrow and remove the clear film.




protective cap

Black Photo Photo Cyan Magenta
Cyan Magenta

3

4

Hold the ink tank as shown in the
diagram and remove the protective cap.

= Notes ink port
* Do not squeeze the sides of %
the ink tanks as this may S
cause the ink to leak out and ‘Q} &}

stain your clothes and hands.
* Do not touch the ink port.
* Do not attempt to reattach the
protective cap once it has
been removed.

Insert the yellow ink tank into the right-
hand slot. Press the top until it clicks
into place.

Use the same procedure to install the
other ink tanks in their appropriate slots.

Check the labels to make sure that each tank is in the
correct position.

= Notes

* Only install the ink tanks in the positions specified
by the labels.

« If ink tanks are not installed in the right position,
colors will not be printed correctly. Immediately
reinstall the tank in the correct position and carry
out print head cleaning. For details, refer to the
User’s Guide.

Close the front cover.

Wait until the POWER lamp remains fully lit (about 60
seconds).



4 Loading Paper

B Loading A4 (Letter) Size Plain Paper
paper thickness lever 1 Open the front cover.

2 Move the paper thickness lever at the
top of the print head holder to the left
position. Close the front cover.

= Note

Set the paper thickness lever to the left when using
plain paper, to the right when using thick paper.
Refer to the User’s Guide for information on loading
envelopes and other media.

3 Load the paper, aligning it with the right
side of the sheet feeder.
You can load up to 100 sheets of plain paper. Do not

exceed this limit. After printing, do not stack more than
40 sheets in the paper output tray.

4 Press the paper guide and slide it
against the left side of the stack of

paper.

You now need to install the printer driver:

Windows: Go to page 8
Mac OS 8.6 - 9.x: Go to page 10
Mac OS X: Go to page 12




5 Installing the Printer Driver

B Installing the Printer Driver - Windows

= Notes

* Do not disconnect the cable or remove the CD-ROM during the installation. The driver cannot be
correctly installed.

* The screens below refer to Windows XP installation. Screen may differ depending on the operating
system you are using.

» When installing the printer driver in Windows XP or Windows 2000, log on to the system as a
member of the Administrators group.

If the following screen appears automatically, click Cancel and follow steps 1 to 7 to install the printer
driver.

‘Welcome to the Found New
Hardware Wizard

This wizard helps you nstal software for

Special Notes for Windows 98 or Windows Me USB Users

Click Cancel to quit the screen and turn off the printer. Next, remove and replace the USB cable
connected to your computer.

1 Ensure the printer and computer are
switched off.

2 Turn on the computer and start
Windows. If any applications
automatically run, quit them.

Disable any virus detection programs.
Do NOT turn the printer on at this stage.




Printer Driver

Documentation | |

Exit | tigzll ' Next )

s _ Readme

Printer Port

n between the printer and the

F
1
2
3

Printer port will be detected. Please wait

completed

t
Manual Selection,

Priter Diver Installed

3 Place the Setup Software & User’s

Guide CD-ROM in the CD-ROM drive.

= Notes

« If the CD-ROM does not run automatically, click
Start and select My Computer, then double-click
the CD-ROM icon. For non-XP Windows, double-
click My Computer in the Windows screen, then
double-click the CD-ROM icon.

« If the language selection screen appears, select a
language, then click OK.

Follow the instructions displayed on
screen. When the screen shown on the
left is displayed, click Install.

When the screen shown on the left
appears, turn the printer on.

If the printer is recognized, the printer driver will be
automatically installed.

= Note

If the connection is not recognized, refer to the
section “Notes on Handling the USB Interface (for
Windows Users)” on page 23.

6 Click OK.



Canon

Printer Driver

[ Documentation

ik the bton o evecute

View Documents

7 When the screen shown on the left

appears, click Exit.

Before you use the printer, you must carry out print head
alignment on page 14.

= Notes

* To view the User’s Guide, please refer to page 23.
+ If a message prompting you to restart the
computer appears, click Yes.

B Installing the Printer Driver — Macintosh

= Notes

* Do not remove or insert the USB cable during installation, as this may result in the computer or
printer not operating correctly.

* Before installing the driver, disable all virus detection programs and automatically loading
programs or remove them from your system folder.

* The Setup Software & User’s Guide CD-ROM contains the application software, ImageBrowser,
PhotoStitch and Easy-PhotoPrint. If you want to install these applications, double-click the
application folder, then double-click the appropriate folder and then Installer. Refer to the Photo

Application Guide in your CD-ROM.

[ canon_BJ
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IHPORTANT-READ THIS AGREEIENT BEFORE INSTALL
PRInT: e

FOR SUBBLE-JET PRINTER, Y0U ARE DEEHED TO

M

LING THE PRINTER DRIVER FOR BUBBLE-JET

For Mac OS 8.6-9.x Users

1
2

Turn on the Mac.

Place the Setup Software & User’s
Guide CD-ROM in the CD-ROM drive.

Double-click the Mac OS 8.6-9.x folder.

Double-click the Printer Driver folder,
then select a language.

Double-click Installer.

Read the Licence Agreement and click
Accept to continue.



7 Click Install.

Glick “Install" to install the following software: After the installation is 1 1 1 1
ekl st e olow Wait for the installation to finish.
19100 QuickDraw printer driver
+19100 printer utilties

Easy Install E

+i9100 printer profile

= Note
r ) No other applications can be running during
Mo ville st nte i ‘SYST this Installation. Click Continue to
automatically guit all other running

applications. Click Cancel to leave your
disks untouched.

(oneme )

If the above message appears, check that there are
no unsaved documents, then click the Continue
button. If a document needs to be saved, click
Cancel then save the document. After saving the
document, begin again from step 4.

) Installation was successful. You have installed
software which requires you to restart your

8 Click Restart.
computer. Ifyou are finished, click Restart, or ifyou

wish to perform additional installations, click The computer restarts.

Continue.

File Edit View Special @ Help

9 Select Chooser in the Apple Menu.

I L L
‘ Chooser

EPSONStatusMonitor 3
[, Favorites

Key Caps

Network Browser

Gl RecentApplications
[Gl Recent Documents
By RecentServers

£ Remote Access Status
Scrapbook

(i Screen Snapz

& Sherlock 2

<! stickies

= 10 Click the icon for the printer you are

R using and close Chooser.

1B100GServer)  Laserwriter 8

s

. ®active

AppleTal

I

Olmsctve 74, Before you use the printer, you must carry out print head
alignment on page 16.

= Note

Refer to the User’s Guide when using this printer as
a network printer.

11
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| | [

e g~ (7 Printer Driver
l@mo 180 Dkql
Deutsch English Espariol
[ |
Frangais allano Nederlands
Authenticate
G Installer requires that you type your passphrase.
Id
Name: |

Passwerd or phrase:

[¥) petaits
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For Mac OS X Users

1
2

5

Turn on the Mac.

Place the Setup Software & User’s
Guide CD-ROM in the CD-ROM drive.

Double-click the Mac OS X folder, then
double-click the printer driver folder.

Double-click 9100 180.pkg.

Enter an administrator name and a
password, then click OK.

Click Continue.



o 7 Read the License Agreement and click

Software License Agreement

Cra— Continue, then click Agree.

canon sorTmas s AT 0

IMPORTANT-READ THIS AGREEMENT BEFORE INSTALLING THE
PRINTER DRIVER FOR BUBBLE-JET PRINTER. BY INSTALLING THE
PRINTER DRIVER FOR BUBBLE-JET PRINTER, YOU ARE DEEMED
TO AGREE TO BE BOUND EEVENT.

This leg:
Canon

BY INSTALLING THE PRINTER DRIVER FOR BUBBLE-JET PRNTER
(THE "SOFTWARE"), YOU ARE DEEMED TO AGREE TO BE BOUND.

BY THE TERMS OF THIS AGREEMENT. IF YOU DO NOT AGREE TO
THE TERNS OF THIS AGREEMENT, DO NOT INSTALL THE
'SOFTWARE AND PROMPTLY RETURN THE CANON DISK TO THE
PLACE WHERE YOU OBTAINED IT FOR A REFUND BEFORE THEY  |_

Crrnt. ) (Csave ) (Gosack { ( Continue )

) install 8 pri

8 Select the Operating System to where
you want to install the printer driver, and
click Continue.

. ] 9 Click Install.

Easy Install

Click Install to perform a basic installation of this
software package.

(Gosack ( ( instai )

10 A message asking for your confirmation
to restart your computer appears on the
screen. Read the message, then click
Continue Installation.

Software installation will start.

( GoBack ) (instal )

e Install

11 Software installation is complete.
Restart your computer.

Install Software

Before you use the printer, you must carry out print head
alignment. For instructions on how to align the print
head, refer to the Printer Driver Guide for Mac OS X. To
view the Printer Driver Guide for Mac OS X, double-
click the Manual folder and Additional Guide for OSX
) User’s folder and select the language folder that you use
as necessary.

The software was successfully installed

Click Restart to finish installing the software

You can also refer to the Printer Driver Guide for Mac
OS X for instructions on how to use the printer driver.

13



6 Aligning the Print Head

This operation must be carried out when using the printer for the first time. Aligning the print head positions
allows you to print without shifts in the color registration.

B Aligning the Print Head — Windows

1 Click Start and select Control Panel,
Printers and Other Hardware, and
then Printers and Faxes.

= Note

For non-XP Windows, click Start, then select
Settings, Printers.

2 Click the icon for your printer.

T 3 Open the File menu and select:

[l edit vien Favories Toos Help

* Windows XP/Windows 2000 —
[Printing Preferences...]
* Windows Me/Windows 98 —[Properties]

to open the setting screen.

Canon 9100 (%) 4 CIle OK

) This printer requires print head alignment.
Click Print Head Alignment on the Maintenance tab to start aignment.

& Canon 19100 Printing Preferences.

5 Click the Maintenance tab, and click
Print Head Alignment.

nnnnnn

6 Check that paper is loaded in the printer
and click OK. If a message warning you
not to perform other operations
appears, click OK.

14



Ganon i9100)

sbly Fain or patchy, cck No and ry again

Print Head Alignment: E| >

Print head alignment is being xecuted. Fefening to printed
palteins & to F, select the pattern that shows no flaws.

Horizontal Alignment (-3 to -

£ Black: i =
B. Cyan =
C Magenta: =

D. Photo Cyar [t} 3:
E. Photo Magenta: It} 3:

Bi-diectionsl Alignment [-5 to +5)

E. Birdirzctional: [t} 33

Print Head Alignment ‘E| 3

Frint head alignment is being executed. Refering to printed
patterns A to F, select the pattern that shows no flaws.

Harizantal Alignment (-3 ko +7)

&, Black: -1 3
0 3

B. Cyan: =
= C. Magenta =]
= D. Photo Cyan o=
E E.PhotoMagenta: | [0 =]

Canon i%100

.
1 ) Print head alignment is now complete.

7 After the pattern is printed, click Yes.

If the pattern is not printed successfully, open the front
cover and ensure that the ink tanks are correctly
installed.

Look at the print-out. From the patterns
in A, select the most even, least
irregular pattern and enter the number.

In the same way, one by one, select the
most even patterns printed with the
least irregularities from each of B to F,
enter their numbers, and click OK.

If it is difficult to pick the best pattern on F, pick the
setting that produces the least noticeable vertical white
stripes.

Less noticeable
white stripes

More noticeable
white stripes

10 Click OK.

This completes the printer setup. The printer is now
ready to use.

15



B Aligning the Print Head — Macintosh

= Note
For Mac OS X users, refer to the Printer Driver Guide for Mac OS X for instructions on how to align
the print head.

Select Page Setup in the File menu.
S Ve Click Utilities.

.
scoe: [[0E) %
orentation:

[I'save settings

Canon 9100 Printer Utility Vversion 4.3

9 Nozzle Check
Prints a nozzle-check pattern.
)| |rrintHead atignment
it will align the print heads to correct any

errorin their installation position.

Print head alignment is being executed.
Alignment entails printing, so do the
following: Ready the printer (connect the
cable and turn the power on), move the
printer's paper thickness lever to the left,
and load a sheet of plain paperinthe sheet
feeder.

Do you want to print head alignment
patterns?

Print Head Alignment

Print head alignment is being executed. Referring to printed patterns
AtoF, select the pattern that shows no flaws.

Adjust sideways(-3~4

=
= B. Cyan:

lil C Magenta:

5

£

5

D. Photo Cyan :

E. Photo Magenta: [0 |
Adjust both ways(-5~+5)

F. BothWays:
Cancel

16

Select Test Print from the menu and
click Print Head Alignment.

Check that paper is loaded in the printer
and click OK.

If the pattern is not printed successfully, open the front
cover and ensure that the ink tanks are correctly
installed.

Look at the print-out. From the patterns
in A, select the most even, least
irregular pattern and enter the number.



Print Head Alignment

Print head alignment is being executed. Referring to printed patterns
AtoF, select the pattern that shows noflaws.

Adjust sideways(-3~+7)
A, Black:

B. Cyan:
C. Magenta:

D. Photo Cyan :
E. Photo Magenta :
Adjust both ways(-5~45
F. Bothways :

()

Canon 19100 Printer Utility Version 4.3
9 Nozzle Ct
@ Print Head Alignment
Itwill align the print heads to correct any
arrorin theirinstallation position.
canonioton Version 4.3{
o< ]
*
Custom.. |
.

6 Inthe same way, one by one, select the
most even patterns printed with the
least irregularities from each of B to F,
enter their numbers and click Send.

If it is difficult to pick the best pattern on F, pick the
setting that produces the least noticeable vertical white
stripes.

Less noticeable
white stripes

More noticeable
white stripes

7 Click Close.

8 Click OK.

This completes the printer setup. The printer is now
ready to use.

17



Basic Operations

* If you detect smoke, unusual smells or strange noises around the printer, immediately switch the
printer off and always unplug the printer. Contact your local Canon service representative.
* To avoid injury, never put your hand or fingers inside the printer while it is printing.

Printing with Windows

Adjusting the print settings according to your needs allows you to produce better quality prints.
In this section, we will use WordPad for the purpose of explanation. The procedures you use and the screens
that appear on your computer may differ according to the application that you use.

B Printing

1 Print the document from the application.

M. Cr+M E % . . .
}v On the File menu, click Print.

Open... 0
Save Crk+s . .

— Check the application’s users manual for the actual

| — procedures.

Prink Previen
Page Setup...

10w |Westem v B
Save fis...

Send...

Exit

\ . .
& prin 2 2 Ensure your printer is selected, then

click:

* Windows XP —[Preferences]
* Windows Me/Windows 98 —[Properties]
* Windows 2000 —[Main] tab

O Pages: 1-65635 .! .!

page range. For swample, 512

3 Specify the required settings and click
OK.

= Note

If you use anything other than plain paper, please
refer to “Basic Print Settings” on page 19.

4 To start printing, click Print.

Printing will start in a few moments.

18



B Basic Print Settings

For the best print quality, specify the minimum requirement settings in the Main tab. To get the best
results, ensure you select the type of media loaded in the printer when printing on paper other than plain

paper.

2 Printing Preferences

& F‘nr\tAdvlsnr

&) Main |£Z Page Setup | @] Stamp/Background | ## Effects | (9 Profiles | d} Maintenance

:ulu. Fiinting
F‘Ialn Paper

Medja Type: Plain Paper

€

Faper Source: Auto Sheet Feeder

Print Qualiy D
® Standard (2)
) Diaft
O Custom )

Color Adjustment: @ byto 3
) Manual ( )

[ Grayseale Printing

[ Preview before printing

[ ok

| [ cancel (\[ Help L

(1) Media Type

Select the type of media loaded in the printer.

(2) Print Quality

Select one option from High, Standard and Draft. Select Custom to
set the print quality manually.

(3) Color Adjustment

If you wish to control the color adjustment settings in more detail,
select Manual.

(4) Preview before printing

Select this to check the layout before printing.

(5) Help

Click this for a more detailed explanation of the functions in the tab.
(This may not appear when using Windows XP or Windows 2000. If
this happens, click Start then select All Programs (or Programs) -
Canon i9100 - Guide).

(6)?

Click this to change the cursor shape to ?. By clicking on the item’s
name with this ? cursor, an explanation will be displayed.

= Notes

* Clicking the Print Advisor allows you to change to the most appropriate print settings simply by
answering questions when prompted.

* Use the application to set the paper size and paper orientation. Before printing, open the settings
screen and check that the Page Size in the Page Setup tab is the same as that specified within

application.

* Refer to the User’s Guide for more information about printer driver functionality.

19



Printing with Macintosh

Adjusting the print settings according to your needs allows you to produce better quality prints.

B Printing

3 Edit Font Size Sty
= New 8N
[ | Open.. 30
Close BW
Save 8S
Save As...

Page Setup... .
Print... #P

Print One Copy

Quit

*0Q

canoni9100

émmit Font Size Style So
(] New #N PV———=

| Open... 30
Close EW
Save 8S
Save As...
Page Setup...

Print... *#P
Print One Copy'

Quit

*0Q

Canon i9100

20

1 Open the Page Setup dialog box in

your application.

On the File menu, click Page Setup. Check the
application’s users manual for the actual procedures.

Specify the page setup.

For details, refer to “Page Setup” on page 21.

Open the Print dialog box in your
application to print the document.

On the File menu, click Print. Check the application’s
users manual for the actual procedures.

Specify the print settings according to
your requirements.

For details, refer to “Basic Print Settings” on page 21.

Click Print.

Printing will start in a few moments.



B Page Setup

Use the Page Setup dialog box to specify the paper size settings.

Canonig100

Version 4.3

Height:207.0mm  Width:210.0mm

[ x |
Paper size {{ A4 s Ca= | Select paper size
[ Borderless Printing you wish to use.
Amount of Extension :
Min, oy Max.

Scale: ‘ %
Orientation :

[J Save Settings

Basic Print Settings

For the best print quality, specify the minimum requirement settings in the Print dialog box. To get the
best results, ensure you select the type of media loaded in the printer when printing on paper other than

plain paper.
Canon 9100 Yersion 4.3
: ; Sl (W} S )
Pages: @ All -
orem [ ] [ ]
BJ Cartridge :
[ Photo =]
Media Type :
{ Plain Paper B )—— (1 )
Paper Source :
Ad [Autu Feeder i]
Normal-size Print Mode :
printing ([ﬁt i])—l—ms—)—— (2)
[ Grayscale Printing

(1) Media Type

Select the type of media loaded in the printer.

(2) Print Mode

Select the type of document you want to print.
To specify more detailed settings for the print quality or color, select
Manual and click Details.

Click this to start printing.

(3) Print

= Notes

+ See Balloon Help for more information about other printer driver functions.
Select Show Balloons in the Help menu for an explanation of each of the items in the setting
screen. To see the explanation, point to the item with the mouse.

* Refer to the User’s Guide for more information about printer driver functionality.

21



Print Head Maintenance

B If Blurring Occurs or If a Specific Color Does Not Print

Perform print head cleaning to improve the print quality. Ensure that the printer is turned on and follow
the instructions below.

* Windows
Open the printer driver settings screen and click the Maintenance tab. Click Cleaning.
See page 14 for details on how to open the setting screen.

* Macintosh
Open the Page Setup dialog box and click Utilities. Click Cleaning.

B When the Printer Runs out of Ink

Replace the empty ink tank with a new one.
Specify the following ink tanks when purchasing.

Yellow BCI-6Y
Magenta BCI-6M
Cyan BCI-6C

Photo Magenta BCI-6PM Photo
Photo Cyan BCI-6PC Photo
Black BCI-6BK

1 Open the front cover and remove the
empty ink tank.

Do not touch the lock lever.

r “
\ﬁ @\ 2 Install the new ink tank.

Close the front cover when finished.

= Note

For more details about maintenance, refer to the
User’s Guide.




Notes on Handling the USB Interface (for Windows Users)

If installation of the printer driver does not proceed as instructed in this Quick Start Guide, there may be a
problem with the USB driver installation.
Try reinstalling the printer driver.

B Reinstalling
If you cannot proceed beyond the Printer Port screen:

Click Cancel.

When the Terminate Installation screen is
displayed, click OK.

Click Exit, then remove the CD-ROM.
Turn the printer off.

2.Tum the printer on.

3 Printer port will be detected. Please wait

completed.

It
Manualselection.

Restart the computer.

OGN AW N=

Reinstall the printer driver (see page 8).

For Further Details...

For more information, place the Setup Software & User’s Guide CD-ROM in the CD-ROM drive.

B User’s Guide Contents

The “User’s Guide” is an HTML manual you can browse through on your computer.

Contents

* How to Use This Manual * Checking the Status of the Printer

¢ Printer Parts and Their Function * Routine Maintenance

* Further Printing Techniques * Troubleshooting

* Printing Media » Appendix

B How to View the User’s Guide

For Windows For Macintosh

(1) Load the CD-ROM in your computer. (1) Load the CD-ROM in your computer.

(2) Click Documentation at left of the screen. (2) Double-click the Manual folder.

(3) Click View Documents. (3) Select a language folder.

(4) When a message appears, click (4) Double-click the User’s Guide folder.
* Yes — to install the User’s Guide (5) Double-click the icon for the
* No — only to browse the User’s Guide i9100_UG_ENG.htm file.

(5) Select User’s Guide and click OK.
Follow the instructions on screen.
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BJ Printer Driver Systems Requirements

For Windows

+ Use a computer on which Windows XP, Windows 2000, Windows Me or Windows 98 can
operate.

» USB* interface

* Available hard-disk space for printer driver installation

Windows XP/Windows 2000 : 50MB
Windows Me/Windows 98 : 15MB

* USB operation can only be guaranteed on a PC with pre-installed Windows XP, Windows
2000, Windows Me, or Windows 98. (This includes Windows XP, Windows 2000 or Windows
Me upgraded from pre-installed Windows 98 or later)

For Macintosh

(Macintosh 8.6-9.x)

+ Use a Macintosh series computer equipped with USB interface on which Mac OS 8.6-9.x can
operate.

* 30MB of available hard-disk space for printer driver installation.

(Macintosh OS X)
+ Use a Macintosh series computer equipped with USB interface on which Mac OS X v10.2.1 or
later can operate.
* 100MB of available hard-disk space for printer driver installation.
* The following functions are not supported:
- Shared printer in the network (will be supported as an OS function with Mac OS X v10.2 or
later)
- Duplex Printing
- Photo Optimizer PRO

+ If you want to use an application, first install the application contained in the Mac OS X folder.

Additional Systems Requirements for User’s Guide

« Pentium® 75 MHz equivalent or higher processor (Pentium® 133MHz equivalent or higher
processor recommended)

 2x or higher CD-ROM drive (4x or higher recommended)

* 20 MB of available hard-disk space (when installing the User’s Guide)

* Microsoft Internet Explorer 5.0 or later






QA7-2670-V01 XX2003XX ©CANON INC.2003 PRINTED IN THAILAND





